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About this book

This book provides instructions for installing and configuring IBM®  Software 
Configuration and Library Manager (SCLM) Administrator Toolkit.

This book is designed to help SCLM project administrators and installation personnel 
perform these tasks:

• Plan for and install SCLM Administrator Toolkit

• Customize the  SCLM Administrator Toolkit environment

• Use SCLM Administrator Toolkit with other products comprising IBM’s SCLM 
Suite.

This manual is a companion to the IBM SCLM Administrator Toolkit: User’s Guide,  
SC31-6571.   The User’s Guide provides information required to use the SCLM 
Administrator Toolkit to define, modify, and administer SCLM projects from either a 
client workstation or host ISPF panels, and to administer IBM Enhanced Access 
Control for SCLM for z/OS® from a client workstation.  This manual also contains the 
product messages. 

Always check the SCLM Administrator Toolkit Library page for the most current 
version of these publications:  

http://www.ibm.com/software/awdtools/sclmsuite/admintoolkit/library

Who should read this book

This book is intended for those persons responsible for installing and customizing 
SCLM Administrator Toolkit and assumes a working knowledge of:

• The z/OS operating system

• IBM Eclipse SDK (IES) 3.0 or higher 

• ISPF

• SCLM

• SMP/E

• RACF®, if administering IBM Enhanced Access Control for SCLM for z/OS

• TCP/IP

Conventions and terminology used in this book

This book uses the following highlighting conventions:

• Boldface type indicates commands or user interface controls such as names of 
fields, folder, icons, or menu choices.

• Monospace type indicates examples of text that you enter exactly as shown.

• Italic type indicates variables that you should replace with a value. It is also used 
to indicate book titles and to emphasize significant words.

The following labels identify significant elements within this book:

• Definition: is used to identify and define terminology unique to this product.

• Example: is used to identify example code or scenarios.

• In this chapter: is used to identify the significant subsections within each chapter.
© Copyright IBM Corp.  2004, 2005  v

http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library/
http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library/
http://www-3.ibm.com/software/awdtools/sclmsuite/sclm/library/
http://www.ibm.com/software/awdtools/sclmsuite/admintoolkit/lib


 

• Recommendation: is used to provide guidance when more than one option is 
available.

• Related reading: is used to refer you to other publications that contain relevant 
information.

• Restriction: is used to identify a restriction or limitation with this product or an 
associated procedure.

Terminology used in this book

In this book, IBM Software Configuration and Library Manager (SCLM) 
Administrator Toolkit for z/OS is referred to as “SCLM Administrator Toolkit," and 
where the meaning is clear, just as the Toolkit.  IBM Enhanced Access Control for 
SCLM for z/OS is referred to as "Enhanced Access Control for SCLM."  IBM Breeze for 
SCLM for z/OS is referred to as "Breeze".

Service updates and support information

To find service updates and support information, including software FixPaks, PTFs, 
Frequently Asked Question (FAQs), technical notes, troubleshooting information, and 
downloads, refer to the following Web page:

http://www.ibm.com/software/awdtools/sclmsuite/admintoolkit/library

Using LookAt to obtain message explanations

LookAt is an online facility that displays explanations for most messages that you 
encounter, as well as for some system abends and codes. You can access LookAt: 

• From the Internet at:

www.ibm.com/eserver/zseries/zos/bkserv/lookat/

• From anywhere in z/OS where you can access a TSO/E command line (for 
example, a TSO/E prompt, ISPF, or z/OS UNIX System Services running OMVS). 
To use LookAt as a TSO/E command, LookAt must be installed on your host 
system. Obtain the LookAt code for TSO/E from a disk on your z/OS Collection 
(SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/ZOS/

• From your Palm™ VIIx personal data assistant (PDA). To use LookAt from your 
Palm VIIx PDA, LookAt must be installed on the PDA. Obtain the LookAt code 
from a disk on your z/OS Collection (SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/PALM/

 

Where to find information

The SCLM Suite Web page and web pages for the component products of the SCLM 
Suite provide current product documentation that you can view, print, and download. 
To locate publications with the most up-to-date information, refer to the following 
Web pages:  

http://www.ibm.com/software/awdtools/sclmsuite/admintoolkit/library

IBM Redbooks® that cover the SCLM Suite are available from the following Web page:
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Information about configuring your MVS system for client-host communications can 
be found in the z/OS Communications Server library, available from the following 
web page:

www-1.ibm.com/servers/eserver/zseries/zos/bkserv/r5pdf/commserv.html

Information about UNIX System Services can be found in the UNIX System Services 
library, available from the following web page:

http:www-1.ibm.com/servers/eserver/zseries/zos/unix/bpxa1pub.html

Accessibility features

Accessibility features help a user who has a physical disability, such as restricted 
mobility or limited vision, to use a software product successfully. The major 
accessibility features in SCLM Administrator Toolkit enable users to:

• Use assistive technologies such as screen readers and screen magnifier software. 
Consult the assistive technology documentation for specific information when 
using it to access z/OS interfaces.

• Customize display attributes such as color, contrast, and font size.

• Operate specific or equivalent features using only the keyboard. Refer to the 
following publications for information about accessing ISPF interfaces:

— z/OS ISPF User’s Guide, Volume 1, SC34-4822

— z/OS TSO/E Primer, SA22-7787

— z/OS TSO/E User’s Guide, SA22-7794

These guides describe how to use ISPF, including the use of keyboard shortcuts or 
function keys (PF keys), include the default settings for the PF keys, and explain 
how to modify their functions.

Additional accessibility information is found in this manual in Appendix B, 
“Accessibility Features of the Workstation Component,” on page 43.

Navigating in a workstation panel

When you use the Tab key to navigate through a workstation panel, as you move from 
field to field, one of the letters in each of the descriptions is underlined.  This provides 
a keyboard shortcut to the field in question.  This behavior does not occur when using 
the mouse to select a field on the panel.

Copying and pasting while using the workstation interface

If you want to copy information from a text field or paste information into a text field, 
place your cursor in the field in question.  To copy, select the text to be copied, right-
click in the text field, and select Copy from the pop-up menu.  To paste information 
into a text field, place your cursor into the field in question, right-click, and select 
Paste from the pop-up menu.  Ctrl+C and Ctrl+A, respectively, copy selected text or 
all text to the clipboard for your use.   Ctrl+V pastes the text to a place you select.
   About this book  vii

http://publib-b.boulder.ibm.com/Redbooks.nsf/Redbooks?SearchVie
www-1.ibm.com/servers/eserver/zseries/zos/bkserv/r5pdf/commserv
http://publib-b.boulder.ibm.com/Redbooks.nsf
http://publib-b.boulder.ibm.com/Redbooks.nsf
http:www-1.ibm.com/servers/zservers/eseries/zose/bkserv/zose/c-
http:www-1.ibm.com/servers/zservers/eseries/zose/bkserv/zose/c-
http://www-1.ibm.com/servers/eseries/zseries/zos/unix/bpxa1pub.
http://www-1.ibm.com/servers/eseries/zseries/zos/unix/bpxa1pub.
www-1.ibm.com/servers/eserver/zseries/zos/bkserv/r5pdf/commserv


 

How to send your comments

Your feedback is important in helping to provide the most accurate and high-quality 
information. If you have any comments about this book or any other SCLM 
Administrator Toolkit documentation, print and fill out the reader comment form 
located at the back of this book. You can use the following methods to return the form: 

• Give it to your local IBM branch office or IBM representative.

• Send it to the address printed on the reader comment form. 

• Send your comments by e-mail to comments@us.ibm.com.

What’s new in Version 2.1

SCLM Administrator Toolkit Version 2.1 provides the following new or improved  
functionality:

• A Remote Migration Wizard is available from the workstation and assists you in 
migrating workstation-based files into an SCLM project and placing them under 
SCLM control. Once launched, the Remote Migration Wizard copies the remote 
assets you selected into the target SCLM-managed library, updates an accounting 
file, and displays a report that details the results of the migration.

• Support for copybooks permits you to assign reusable elements of a project 
definition to copybooks where they can be used by other projects.

• When importing an SCLM project, the product discovers existing group/type 
data sets and automatically adds them to the project.

• Custom user macros can now be included within your project definition.

• The Language Definition Wizard has been enhanced by replacing the free-form 
editor with intelligent Wizard panels.  In addition, context sensitive fields 
throughout the Wizard maintain the consistency of the definition.  The 
information supplied using the Language Definition Wizard is more easily made 
available to other Wizards for their use.

• New VSAM tasks are distributed with the project.  Additional default groups and 
types have also been added.

• A Quick Navigation facility has been added to the ISPF interface to improve the 
speed and flexibility of navigating through the host components.  

• Performance for large projects is improved.

• A set of ISPF panels assist you in downloading and installing the workstation 
client.

• At the workstation, in addition to using COPY and PASTE from a pop-up menu, 
you may now use Ctrl+C and Ctrl+A, respectively, to copy selected text or all text 
to the clipboard.   Ctrl+V pastes the text to a place you select.

• New preferences are provided to assist you in determining and controlling the 
size of log files.

• Other improvements have added to enhance the product’s ease of use and 
performance. 

In this current Installation and Customization Guide, a program has been added that 
simplifies the customization of ispf.sh and setup.sh.  You may, however, continue to 
customize these scripts manually, if you so desire.

A new Preferences page in RSE 6.0.3 permits you to control file cache size and clear 
the cache. If you do so while you have an open project, you will impact your ability to 
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correctly save your project. Thus, you must not clear the cache while you have 
projects open in SCLM Administrator Toolkit.
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Part 1. Introduction

This part describes the IBM Software Configuration and Library Manager (SCLM) 
Administrator Toolkit.
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Chapter 1. About the SCLM Administrator Toolkit

IBM's SCLM is a program that provides software configuration and library 
management for the z/OS platform. Using the SCLM Administrator Toolkit, you can 
address the complexity of setting up an SCLM project initially, performing day-to-day 
project maintenance, and managing access control from a workstation. It provides the  
simplicity and functionality you need at an attractive cost. 

Because SCLM Administrator Toolkit provides both a GUI and an ISPF interface,  you 
can work in the environment in which you're most comfortable.  While  SCLM 
Administrator Toolkit functions run primarily in the foreground, the product 
supports both batch and online execution for project creation, project cloning, and 
VSAM file maintenance.  You can choose immediate response when you require it, or 
can defer processing to a more convenient time.  To choose either immediate or 
deferred processing when using the workstation, select Preferences > SCLM Admin 
Toolkit from the Window pull-down. When using ISPF, you can specify this 
information by selecting the Settings option on the SCLM Main Menu.

You can get started easily with SCLM Administrator Toolkit by invoking the SCLM 
Project Wizard, either from a workstation or from an ISPF host session, to create a new 
project or modify an existing one.  When creating a new project, the fields in the 
Project Wizard will be populated with default values.  When modifying an existing 
project, the fields contain that project’s defined values.

Using the Project Wizard, you can define the elements that comprise your project.   
When using the workstation, your changes are saved to the host when you press the 
Save button on the menu bar.  The changes are not saved locally.  If you attempt to 
close your project  while you have unsaved changes,  SCLM Administrator Toolkit 
will prompt you to save before you close.  As you navigate through the panels of  the 
Project Wizard  using ISPF, that data is saved at the host.

Thus, at any time, you can choose to stop work before you have fully defined the 
project.  SCLM Administrator Toolkit saves your work so that you can pick it up in a 
later session.

When defining a group using the workstation interface, you can drag and drop boxes 
around your display, building a network of linked boxes much like an organization 
chart. Each box represents an SCLM group.  Once you have completed your 
definition, SCLM Administrator Toolkit generates default authorization codes and 
PROMOTE definitions, which you can modify if you so choose. A  process to add or 
modify groups is also available at the host using ISPF panels. 

Using the Project Wizard, you can  configure any user exits you may require, 
including the Breeze user exits, if you have installed Breeze.  You can add language 
types, or you can modify them using the Language Definition Wizard.

Other functions provided by the SCLM Administrator Toolkit include:

• The ability to update and run your VSAM tasks and perform VSAM file 
maintenance

• The ability to create architecture definitions manually or by importing them from 
existing JCL or an existing Load Module, guided by the Architecture Definition 
Wizard

• The ability to easily clone an existing project and, if you so desire, its data
© Copyright IBM Corp.  2004, 2005  3



 

• The ability to update and manage SCLM projects that were not created using 
SCLM Administrator Toolkit

Support for Enhanced Access Control for SCLM Administration

Enhanced Access Control for SCLM is a program that enhances RACF security.  The 
SCLM Administrator Toolkit assists you in administering Enhanced Access Control 
for SCLM by:

• Maintaining existing RACF Data Set Profiles,  Enhanced Access Control for SCLM 
Rules Files,  Enhanced Access Control for SCLM Profile Access Rules, and 
Enhanced Access Control for SCLM Applications

• Displaying a list of Enhanced Access Control for SCLM Violations

For additional information about the Enhanced Access Control for SCLM 
administration tasks supported by SCLM Administrator Toolkit, see the SCLM 
Administrator Toolkit User’s Guide.

Hardware and software requirements

The sections that follow provide an overview of the hardware and software 
requirements to run SCLM Administrator Toolkit. Current and complete information, 
including any required APARs and PTFs, is found in the SCLM Administrator Toolkit 
Program Directory.

Note:   When using the Linux and UNIX ports, SCLM Administrator Toolkit is an X-
Client Application. It may be sensitive to the X-Server being used if this is not the X-
Server located on the system.  

Hardware requirements

Required hardware is any hardware environment that supports the required software 
as described in “Software requirements”.

Software requirements

The software required to run SCLM Administrator Toolkit is as follows:

• XML Toolkit for z/OS V1.7

•  J2RE V1.4.2 IBM J9

• z/OS V1.4.2 or later

• IBM SMP/E for z/OS V3.2.0 or later

Note:  IBM Eclipse SDK (IES) 3.0 or higher is required to run SCLM Administrator 
Toolkit.  If you do not already have IBM Eclipse SDK installed, it is installed as part of 
the SCLM Administrator Toolkit installation process.  Remote Systems Explorer (RSE) 
must be at level 6.3.1.
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Part 2. Installation and Customization

This part describes planning for the installation and customization of SCLM 
Administrator Toolkit and performing the installation and customization activities  
that you will need to undertake.  Typically, the installation and customization 
activities on the host are the responsibility of a systems programmer, while installing 
and customizing each workstation client is the responsibility of that client’s user.
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Chapter 2. Planning for Installation

Before installing and customizing SCLM Administrator Toolkit, there are decisions 
you should  make and planning activities you should undertake.  Various people at  
your site may need to be involved in these decision and  planning activities. 

Gather the required information

SCLM Administrator Toolkit provides several kinds of information that will aid you 
with installation and customization.  One is this Installation and Customization 
Guide.  In addition to this Guide, you should gather together the materials you will 
need:

• The product’s Program Directory for information about unloading the product 
from the distribution media onto your system.  The Program Directory explains 
the program materials you have received, installation requirements and 
considerations, and detailed instructions for installing under SMP/E.

• The Read-me document.  If there is any last-minute information you need, a 
Read-me will be included as part of the installation package.

• Manuals from other product libraries that may be needed. A Bibliography is 
included in this manual that lists documentation that may be of assistance when 
installing and customizing SCLM Administrator Toolkit.

Decide on the interface you will use

SCLM Administrator Toolkit provides two interfaces, a GUI-compliant workstation 
client and a host-based ISPF interface.  While you can work on an SCLM 
Administrator Toolkit session from the client and later complete your work at the 
host, or vice versa, it is more likely that each user will pick a preferred method of 
interfacing with SCLM Administrator Toolkit. 

Install any required products and check the maintenance level of your 
installed products

Irrespective of whether you will use the ISPF interface or the workstation-based client 
GUI interface, you should ensure that your system has installed the following 
products and the current maintenance has been applied for:

• SCLM

• ISPF

• TSO

• TCP/IP

• UNIX System Services

• Java Runtime Environment 1.4 or above.  Note that this must be available before 
installing your workstation client. 

• If using the workstation client, the software specific to the workstation that will be 
used

• XML Toolkit for z/OS Version 1.7
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Note that if you will use SCLM Administrator Toolkit from the workstation, you must 
install the SCLM Administrator Toolkit client at the version 2.1 level.  If you have a 
previous version of the client workstation component, you must reinstall the client.

Customize the software

Ideally, the prerequisite software has been customized prior to installing the SCLM 
Administrator Toolkit. The required customization is listed below, with details 
provided later in this manual. 

• CEE.SCEERUN and CEE.SCEERUN2 must be link-listed

• <hilev>SAUZLOAD and the XML LOADLIBs must be APF-authorized

• OMVS must be configured and operational prior to using the GUI client at a 
workstation

• Each user must have an OMVS segment in RACF, with a valid shell and home 
directory specified.

• Each user’s uid must be unique and non-zero.

• Each user must have write authority to /tmp.

• Users that will create language definitions or architecture definitions from JCL 
must have a HOLD CLASS specified in the TSO segment of their RACF user 
profile

• Each user must have the ability to specify a region size of 60000 on the TSO logon 
screen if using the ISPF interface and the XML Toolkit V1R7 is used.

• Users working with the Enhanced Access Control-specific features of SCLM 
Administrator Toolkit must have RACF SPECIAL authority specified in their 
RACF user profiles. 

Involve the appropriate people

In preparing to install and customize the product, you should involve the necessary 
people in planning the installation-- your site’s personnel responsible for:

• TCP/IP customization

• Security administration

• UNIX System Services configuration
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Chapter 3. Installing and Customizing the Host Component

This chapter provides information about the tasks that you must perform to install 
and customize the host component of the SCLM Administrator Toolkit.  

The following tasks typically are performed by a systems programmer:

1. Install SCLM Administrator Toolkit  on your MVS™ system using SMP/E.

2. Customize your MVS system for the product.

3. Customize UNIX System Services (USS) and RACF.

4. Optionally, customize IBM Workload Manager (WLM).

5. If you will use the workstation interface, either customize TCP/IP to invoke 
REXEC or install the RSE daemon.

6. Ensure that each SCLM Administrator Toolkit user is properly configured to use 
the product.

If you will use only the host interface to SCLM Administrator Toolkit, you can stop 
here and begin using ISPF to access the product panels.

If you plan to use the workstation client, complete the tasks above and then:

1. Download and install the SCLM Administrator Toolkit client. An option is 
available from the  SCLM Administrator Toolkit to assist you with this task.

2. Customize the client.

Because enterprises vary in their installation requirements, the customization 
information in this chapter may not be an exhaustive list of the changes required to be 
made to your installation.  Information about installing and customizing the 
workstation component can be found in Chapter 5, “Installing and Configuring the 
Workstation Client,” on page 27.

SMP/E installation

Follow the directions in the Program Directory to install SCLM Administrator Toolkit 
on z/OS.   Then follow the directions in this chapter to install and customize the MVS 
component of the SCLM Administrator Toolkit.   

Installing and customizing the MVS component

After SCLM Administrator Toolkit has been installed, the following post-installation 
steps should be performed.

The recommended directory into which to install SCLM Administrator Toolkit is 
/usr/lpp/.  

 The library <hilev>.SAUZLOAD, as well as AUZ170, must be link-listed, or the 
member AUZAUTH must be copied into a link-listed library and
’F LLA,REFRESH’ entered on the MVS system console
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APF authorization

<hilev>.SAUZLOAD and the XML LOADLIBs must be APF-authorized. 

Customizing AUZUNPAX

The AUZUNPAX job found in AUZ..SAUZSAMP installs the USS components in an 
HFS. This HFS must have at least 30MB of space available. 

The AUZUNPAX job must be run by a user who can become root via the SU 
command.

If you have installed the product into a directory other than /usr/lpp/AUZ, you will 
need to modify AUZUNPAX. The directory you specify as the location in which to 
place the contents of <hilev>.SAUZSAMP(AUZPAX) must be one level above /AUZ/, 
since the installation process creates the AUZ subdirectory and its subdirectories (see 
the listing for AUZUNPAX, below).  In the listing, you may need to modify the 
following statements:

• INSTALL_DIR=/usr/lpp

• pax -rvf"//'AUZ.SAUZSAMP(AUZPAX)'"

You may also need to modify the CLASS, MSGCLASS, MSGLEVEL, NOTIFY, USER, 
GROUP, and PASSWORD parameters specified for the job.

Customization required to modify the SCLM Main Menu 

After SCLM Administrator Toolkit has been installed, it is added to a modified SCLM 
Main Menu as Option 8.  To display the modified SCLM Main Menu in place of the 
standard SCLM Main Menu, you must take the following steps:

If you are running z/OS 1.5 or earlier:

1. Customize the job AUZ.SAUZSAMP(AUZFLMRN) for your installation.  This job 
renames the AUZFLMD panel member to FLMDMN and is needed to display the 
SCLM Main Menu with the SCLM Administrator Toolkit option. 

2. Run job AUZ.SAUZSAMP(AUZFLMRN).

3. Modify your users’ logon PROCs so that AUZ.SAUZPENU is placed ahead of 
ISP.SISPPENU in the ISPPLIB concatenation.  Alternatively, copy 
AUZ.SAUZSAMP(FLMDMN) to such a library.  This causes the SCLM 
Administrator Toolkit version of FLMDMN to be used instead of the version 
provided with ISPF.

If you are running z/OS 1.6 or later:

1. Customize the job AUZ.SAUZSAMP(AUZFLM16) for  your installation.   These 
jobs rename the AUZFLMD panel member to FLMDMN and one or the other is 

Note:  When customizing the various parameters in a CLIST, you must ensure that the case of 
the values you enter exactly matches the case of the corresponding information in your 
Hierarchical File System (HFS) directory.  Thus, for example, if  the HFS directory where 
SCLM Administrator Toolkit resides is /usr/lpp/AUZ/v210/bin, you must ensure that your 
entry for the AUZ  CLIST SPATH shows usr, lpp, v210,  and bin in lower-case letters, and 
AUZ in upper-case letters. 
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needed to display the SCLM Main Menu with the SCLM Administrator Toolkit 
option. 

2. Run job AUZ.SAUZSAMP(AUZFLM16).

3. Modify your users’ logon PROCs so that AUZ.SAUZPENU is placed ahead of 
ISP.SISPPENU in the ISPPLIB concatenation.  Alternatively, copy 
AUZ.SAUZSAMP(FLMDMN) to such a library.  This causes the SCLM 
Administrator Toolkit version of FLMDMN to be used instead of the version 
provided with ISPF.

   

 

If you have previously modified the SCLM Main Menu and want to preserve your 
changes, you can add Option 8 SCLM Administrator Toolkit to your modified Main 
Menu instead of performing the above customization.   Option 8 must execute the 
TSO command  TSO AUZ.

If you are running with z/OS Version 1.6 or later, you can choose whether to issue 
TSO and SCLM commands using  the standard method of entry or whether you will 
use Easy Cmds.  The Easy Cmds option appears as option 6A on the modified SCLM 
Main Menu.   

Customizing the AUZ CLISTs

To start the SCLM Administrator Toolkit user interface, you run the SCLM 
Administrator Toolkit CLISTs. Before doing so, you must first customize two CLISTs, 
AUZ and AUZCLIST, located in the SAUZSAMP sample library, to work in your 
environment.  Then, copy the customized CLISTs from AUZ.SAUZSAMP to a CLIST 
library that is in all users’ SYSPROC concatenation for CLISTs, or modify each user’s 
logon procedure to include AUZ.SAUZSAMP in the concatenation.

   

 

SCLM Administrator Toolkit CLIST member AUZ

The statements comprising member AUZ execute the contents of member AUZCLIST. 
The statements within member AUZ  allow you to start the SCLM Administrator 
Toolkit user interface CLIST, AUZCLIST, as a separate application. This enables you to 
continue your ISPF session should you encounter a problem with this particular 
instance of SCLM Administrator Toolkit. The contents of the SCLM Administrator 
Toolkit CLIST member AUZ are shown below.  You should note that this CLIST as 

Note:  Files  AUZ.SAUZSAMP(AUZFLMRN) and AUZ.SAUZSAMP(AUZFLM16) contain 
both lower and upper case characters. The case of the text must be preserved. Also, the file 
must always be saved NONUM and some lines may have the backslash (\) character in 
column 80.  These must also be preserved. 

Note:  When customizing the various parameters in a CLIST, you must ensure that the case of 
the values you enter exactly matches the case of the corresponding information in your 
Hierarchical File System (HFS) directory.  Thus, for example, if  the HFS directory where 
SCLM Administrator Toolkit resides is /usr/lpp/AUZ/v210/bin, you must ensure that your 
entry for the AUZ  CLIST SPATH shows usr, lpp, v210,  and bin in lower-case letters, and 
AUZ in upper-case letters. 

These files contain both lower and upper case characters. The case of the text must be 
preserved. Also, the file must always be saved NONUM and some lines may have the 
backslash (\) character in column 80.  These must also be preserved. 
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distributed with the product is the most current version and may differ slightly from 
the listing presented here.

To customize  member AUZ, perform the following steps:

1. Copy the AUZ  and AUZCLIST members to a CLIST library that is included in all 
users’ SYSPROC concatenation. You must do so in order to execute the AUZ 
CLIST using TSO.

2. In the PROC 0 CLISTLIB(name) statement, specify the name of the data set to 
which the AUZCLIST member was copied. For example, 
PROC  0 CLISTLIB(ABCD.USER.CLIST)

Contents of AUZ:  

PROC 0 CLISTLIB(name)                                                   00010001
                                                                        00020001
/* Licensed Materials - Property of IBM
/* 5697-J19
/* (c) Copyright IBM Corp. 2004 - 2005  All Rights Reserved
/* (c) Copyright Rocket Software, Inc. 2003 - 2005 All Rights Reserved
/* US Government Users Restricted Rights - Use, duplication or
/* Disclosure restricted by GSA ADP Schedule Contract with
/* IBM Corp.
                                                                        00090000
  CONTROL NOMSG                                                         00100000
  FREE  FILE(AUZCLIST)                                                  00110000
  CONTROL MSG                                                           00120000
                                                                        00130000
  ALLOC FILE(AUZCLIST) DATASET('&CLISTLIB') SHR REU                     00140000
                                                                        00150000
  ALTLIB ACTIVATE APPLICATION(CLIST) FILE(AUZCLIST)                     00160000
                                                                        00170000
  ISPEXEC SELECT CMD(AUZCLIST) NEWAPPL(AUZ) PASSLIB                     00180000
                                                                        00190000
  ALTLIB DEACTIVATE APPLICATION(CLIST)                                  00200000
  FREE  FILE(AUZCLIST)                                                  00210000

SCLM Administrator Toolkit CLIST member AUZCLIST

AUZCLIST starts the SCLM Administrator Toolkit user interface.  The contents of the 
SCLM Administrator Toolkit member AUZCLIST are shown below.  You should note 
that this CLIST as distributed with the product is the most current version and may 
differ slightly from the listing presented here.

To customize member AUZCLIST,  alter the first lines of the CLIST as, for example:

PROC 0 HILEVEL(AUZ.WRK0210)  + 
XMLDSN(XML.HXML170.SIXMMOD1) +
AUZNAME (AUZMAIN)             +
SPATH (//usr/lpp/AUZ/v210/bin)

Set the variables HILEVEL, XMLDSN, AUZNAME, and SPATH  to the appropriate 
values.  

• HILEVEL is the high level qualifier that contains the AUZ datasets. 

• XMLDSN is the data set name of the load library containing the XML toolkit 
dynamic link libraries.

• AUZNAME is the name of the program to drive the ISPF interface. The  variable 
should be AUZ170 for installations using the XML toolkit V1R7 .

• SPATH is the path to the HFS system where scripts have been installed. (Note that 
the value in the parentheses requires a double slash (//) at the beginning of the 
variable.)
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You need to ensure that any data set names after variable substitution do not exceed 
44 characters in length.

Contents of AUZCLIST:  

PROC 0 HILEVEL(HILEVEL) +                                               00010009
       XMLDSN(XMLDSN) +                                                 00020009
       AUZNAME(AUZMAIN) +                                               00030011
       SPATH(//usr/lpp/AUZ/v210/bin)                                    00040015
                                                                        00050005
/* Licensed Materials - Property of IBM
/* 5697-J19
/* (c) Copyright IBM Corp. 2004 - 2005  All Rights Reserved
/* (c) Copyright Rocket Software, Inc. 2003 - 2005 All Rights Reserved
/* US Government Users Restricted Rights - Use, duplication or
/* Disclosure restricted by GSA ADP Schedule Contract with
/* IBM Corp.
                                                                        00120000
/*CONTROL LIST CONLIST SYMLIST                                          00130000
                                                                        00140000
  ISPEXEC VGET (ZUSER ZPREFIX) ASIS                                     00150000
                                                                        00160000
 IF (&ZPREFIX ^= &ZUSER AND &ZPREFIX ^= ) THEN +                         00170003    
    SET &TL = &STR(&ZPREFIX..&ZUSER)                                    00180002
  ELSE +                                                                00190000
    SET &TL = &ZUSER                                                    00200000
                                                                        00210000
  CONTROL NOMSG                                                         00220000
  IF &SYSDSN('&TL..&HILEVEL..ISPTLIB')^=OK THEN +                       00230002
    DO                                                                  00240000
     ALLOC F(XX) DA('&TL..&HILEVEL..ISPTLIB') SPACE(1 1) DIR(30) +      00250002
     CYLINDERS LRECL(80) BLKSIZE(800) DSORG(PO) RECFM(F B) NEW          00260000
    END                                                                 00270000
  FREE  FILE(XX)                                                        00280000
  CONTROL MSG                                                           00290000
                                                                        00300000
  ISPEXEC LIBDEF ISPMLIB  DATASET ID('&HILEVEL..SAUZMENU') UNCOND       00310000
  ISPEXEC LIBDEF ISPPLIB  DATASET ID('&HILEVEL..SAUZPENU') UNCOND       00320000
  ISPEXEC LIBDEF ISPSLIB  DATASET ID('&HILEVEL..SAUZSLIB') UNCOND       00330000
  ISPEXEC LIBDEF ISPLLIB  DATASET ID('&HILEVEL..SAUZLOAD' +             00340017
                                     '&XMLDSN') UNCOND                  00341017
  ISPEXEC LIBDEF ISPTLIB  DATASET ID('&HILEVEL..SAUZTENU' +             00350018
                                     '&TL..&HILEVEL..ISPTLIB') UNCOND   00351018
  ISPEXEC LIBDEF ISPTABL  DATASET ID('&TL..&HILEVEL..ISPTLIB') UNCOND   00360002
                                                                        00370000
  SET &SYSASIS = ON                                                     00380012
  &AUZNAME &SPATH                                                       00390011
                                                                        00400000

Customizing the USS  components

The components of the SCLM Administrator Toolkit that operate under UNIX System 
Services are stored in the directories listed below. The path information is case-
sensitive.

• <install-directory>/AUZ/v210/bin/

• <install-directory>/AUZ/v210/log/

• <install-directory>/AUZ/v210/rseserver631/

• <install-directory>/AUZ/v210/xsl/

In addition to the foregoing, you must verify that the following installation 
requirements are met:

• /tmp must be accessible to and writable by all users
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• /usr/lpp/AUZ/v210/log must be writable by all users.  If the log directory is 
relocated, the relocated directory must be writable by all users.

• /usr/lpp/AUZ/v210/bin/auzauth

— is of size 0

— is executable

— has the t bit set when viewed with ’ls -la/usr/lpp/AUZ/v210/bin/auzauth’.

• /usr/lpp/AUZ/v210/rseserver631/auth has the p bit set when viewed with ’ls -
la/usr/lpp/AUZ/v210/rseserver631/auth’

You must also decide whether you will use REXEC or the RSE daemon.  If you will 
use REXEC, see “Customizing TCP/IP to invoke REXEC” on page 19.  If you plan to 
use the RSE daemon, see “Customization for the RSE daemon” on page 20.

Log directory permissions

Review the permissions for the log directory and ensure that:

• The permissions for the log directory must be 777

• The file rexx.sh.log permissions must be 777

The log directory permissions are set by AUZUNPAX and the file permissions are set 
by the first user of the system. 

Note:  If the first user is root, the file permissions for rexx.sh.log could be other than 
777 and will need to be adjusted.

Customizing IBM Workload Manager (WLM)

In order to prevent UNIX System Services scripts from taking over your system, it is 
recommended that you define a WLM Service Class for Unix System Services that has 
the same performance characteristics as low-priority batch.  However, you may 
choose to define your USS service class as having another priority,  depending on the 
characteristics of your enterprise’s installation. 

Customizing setup.sh and ispf.sh 

Customization may be required in the scripts setup.sh and ispf.sh. 

• setup.sh customization is  always required.  

• ispf.sh customization is required only if you are using the workstation client.

You can run a batch program to perform the customization as described in “Batch 
program to customize setup.sh and ispf.sh” on page 15.  If you would prefer to 
customize these two scripts by hand, you can follow the directions contained within 
the scripts themselves.

The statements that may need to be changed are:  

• export AUZ_MVS_REXX_EXECLIB="AUZ.WRK0210.SAUZEXEC"  

This statement contains the environment variables for the SCLM Administrator 
Toolkit.

• export AUZ_MVS_REXX_LOADLIB="AUZ.WRK0210.SAUZLOAD" 

• export AUZ_MVS_REXX_ISPSLIB="AUZ.WRK0210.ISPSLIB"

• export 
AUZ_MVS_TRANSLATE_FILENAME_BASE="AUZ.WRK0110.LSTRANS"
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• export AUZ_JAVA_SERVICES_PORT=’4445’

• export AUZ_HOME=/usr/lpp/AUZ/v210

• export AUZ_LOG=/usr/lpp/AUZ/v210/log

• export JAVA_HOME=/usr/lpp/java/IBM/J1.4

JAVA_HOME is required only if you will run the workstation part of SCLM 
Administrator Toolkit.   If Java™ is not installed in the usual directory, you must 
modify this statement to point to the installation directory for Java. 

• export XML_VERSION="V1R7M0"

• export XML_HOME=/usr/lpp/ixm/IBM

XML_HOME defines the location where the XML toolkit for z/OS was installed 
and should be modified as appropriate for your installation.

Batch program to customize setup.sh and ispf.sh

If you want to customize setup.sh and ispf.sh using the batch program provided by 
SCLM Administrator Toolkit, use job AUZCUSTJ found in the AUZ.SAUZSAMP 
library.

Alternatively, should you wish to manually customize setup.sh and ispf.sh, follow the 
instructions provided with those scripts in the previous section entitled “Customizing 
setup.sh and ispf.sh” on page 14 .

Note:  In order to run this batch customization, the user ID under which this program 
is run must have root authority.

Customizing setup.sh 

If you prefer to customize setup.sh by hand, you can do so by following the 
instructions imbedded in the script.  Alternatively, you can run a program to perform 
this customization.  See “Batch program to customize setup.sh and ispf.sh”.   A listing 
of setup.sh is included here for your reference.  You should note that the script as 
distributed with the product is the most current version and may differ slightly from 
the listings presented here. 
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Content of setup.sh

#!/bin/sh
#
#   NOTE: setup.sh_template and setup.sh should be kept in sync.
#
#   Usage:   . setup.sh
#
# Licensed Materials - Property of IBM
# 5697-J19
# (c) Copyright IBM Corp. 2004 - 2005  All Rights Reserved
# (c) Copyright Rocket Software, Inc. 2003 - 2005  All Rights Reserved
# US Government Users Restricted Rights - Use, duplication or
# Disclosure restricted by GSA ADP Schedule Contract with
# IBM Corp.
#
#
#   Environment variables for SCLM Administrator Toolkit
#

export AUZ_MVS_REXX_EXECLIB="AUZ.WRK0210.SAUZEXEC"
export AUZ_MVS_REXX_LOADLIB="AUZ.WRK0210.LOADLIB"
export AUZ_MVS_ISPSLIB="AUZ.WRK0210.SAUZSLIB"

export AUZ_MVS_TRANSLATE_FILENAME_BASE="AUZ.WRK0210.LSTRANS"
export AUZ_JAVA_SERVICES_PORT=4445

export AUZ_HOME=/usr/lpp/AUZ/v210
export AUZ_LOG=/usr/lpp/AUZ/v210/log

export JAVA_HOME=/usr/lpp/java/IBM/J1.4

export XML_VERSION=V1R7M0

export XML_HOME=/usr/lpp/ixm/IBM
export XML4C=xml4c-5_4
export XSLT4C=xslt4c-1_7
export JCL2ARCHDEF=jcl2archdef170
export JCL2LDML=jcl2ldml170

SHELL=/bin/sh
LANG=C

export PATH=$PATH:/bin:.:${JAVA_HOME}/bin:${AUZ_HOME}/bin:${XML_HOME}/
${XSLT4C}/bin:/usr/sbin

export ICU_DATA=${XML_HOME}/${XML4C}/lib

export LIBPATH=${XML_HOME}/${XSLT4C}/lib:${XML_HOME}/${XML4C}/lib:
${LIBPATH}

export STEPLIB=${AUZ_MVS_REXX_LOADLIB}:none

Customizing ispf.sh

It may also be necessary to customize the script ispf.sh for your installation.  If you 
prefer to customize ispf.sh by hand, you can do so by following the instructions 
imbedded in the script.  Alternatively, you can run a program to perform this 
customization.  See “Batch program to customize setup.sh and ispf.sh” on page 15. 
You should note that this script as distributed with the product is the most current 
version and may differ slightly from the listing presented here. 

If you are performing a manual customization, the statements that should be 
reviewed and possibly changed are:
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• export TSOALLOC=ispprof:ispplib:ispmlib:isptlib:ispllib:ispslib:\
isptabl:isplog:sysexec

• export isptabl="alloc new unit (sysvio) space (1,1) cyl dir(5) \
recfm (f, b) lrecl (80) blksize (3120)" 

• export ispplib=SYS1.SBPXPENU:ISP.SISPPENU

• export ispmlib=SYS1.SBPXMENU:ISP.SISPMENU

• export isptlib=ISP.SISPTENU

• export ispslib=ISP.SISPSENU

• export ispllib=SYS1.LINKLIB:ISP.SISPLOAD

• export sysexec=SYS1.SBPXEXEC:${AUZ_MVS_REXX_EXECLIB}

Note:  By default, the ISPF log is not written to the spool.  If you want to see the log in 
the spool then you must:

• Comment out the line: export isplog="alloc dummy"    

• Uncomment the line: #export isplog="alloc sysout(a) recfm(v,a) lrecl(125) 
blksize(129)"   
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Content of ispf.sh

#!/bin/sh
# Licensed Materials - Property of IBM
# 5655-L03
# (c) Copyright IBM Corp. 2004, 2005  All Rights Reserved.
# (c) Copyright Rocket Software, Inc. 2003 - 2005  All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or
# Disclosure restricted by GSA ADP Schedule Contract with
# IBM Corp

# Assign the DD names to allocate                                       
#                                                                       
#
export TSOALLOC=ispprof:ispplib:ispmlib:isptlib:ispllib:ispslib:\
isptabl:isplog:sysexec                                                  
#                                                                       
# Allocate an empty, temporary ISPF profile data set                    
#                                                                       
export ispprof="alloc new unit(sysallda) space(1,1) cyl dir(5) \
recfm(f,b) lrecl(80) blksize(3120)"                                     
#                                                                       
# Allocate an empty, temporary ISPF table data set                      
#                                                                       
export isptabl="alloc new unit(sysallda) space(1,1) cyl dir(5) \
recfm(f,b) lrecl(80) blksize(3120)"                                     
#                                                                       
# Allocate the ISPF log to DUMMY
#                                                                       
#export isplog="alloc sysout(a) recfm(v,a) lrecl(125) blksize(129)"      
export isplog="alloc dummy"      
#                                                                       
# Allocate the OpenMVS and ISPF panel data sets to ISPPLIB              
#                                                                       
export ispplib=SYS1.SBPXPENU:ISP.SISPPENU                               
#                                                            
# Allocate the OpenMVS and ISPF message data sets to ISPMLIB            
#                                                                       
export ispmlib=SYS1.SBPXMENU:ISP.SISPMENU                               
#                                                                       
# Allocate the ISPF table data set to ISPTLIB                           
#                                                                       
export isptlib=ISP.SISPTENU                                             
export ispslib=ISP.SISPSENU                                             
#                                                                       
# Allocate any load library to ISPLLIB if ISPF is in LINKLIST/LPA       
#                                                                       
export ispllib=SYS1.LINKLIB:ISP.SISPLOAD 
#                                                                       
# Allocate the OpenMVS EXEC data set to SYSEXEC                         
#                                                                       
export sysexec=SYS1.SBPXEXEC:${AUZ_MVS_REXX_EXECLIB}

Customizing PARMLIB

If you have not done so already, make the following PARMLIB changes:

• CEE.SCEERUN  and CEE.SCEERUN2 must be link-listed

• <hilev>.SAUZLOAD must be APF-authorized
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Customizing TCP/IP to invoke REXEC

If you have chosen to use REXEC rather than the RSE daemon, you will need to 
perform this customization step.  To configure  and activate OMVS REXEC, you must 
perform the following tasks:

1. Deactivate MVSRXSERVE from ports 512 and 514 and relocate to alternate ports, 
for example, 1512 and 1514.  Guidance on setting up orexecd, the remote 
execution server daemon, can be found in  the most recent versions of:

• z/OS Communications Server: IP Configuration Guide, the chapter entitled 
"Remote Execution," as well as in "Appendix A: Setting up the inetd 
configuration file."   

• z/OS Communications Server: IP Configuration Reference, the chapter entitled 
"Remote execution server."  

You should also review any informational APARS on this topic.

2. Modify TCPIP.DATA to AUTOLOG INETD.  An example follows: 

AUTOLOG 5
     FTPD JOBNAME FTPD1 L; FTP Server
     INETD JOBNAME INETD1 ; INETD Server
     OSNMPD ; SNMP Agent Server
     SNMPQE ; SNMP Client
ENDAUTOLOG

3. Reserve ports 512 and 513 to INETD1 as follows:

    512 TCP INETD1 ; OE RLOGIN SERVER 
    513 TCP INETD1 ; OE RLOGIN SERVER 

The user under which INETD1 runs must have read access to the BPX.DAEMON 
profile in the FACILITY class.

4. Create a started task to run in the INETD daemon (inetd) under BPXBATCH. An 
example follows:

//INETD PROC 
//INETD EXEC PGM=BPXBATCH,REGION=30M,TIME=NOLIMIT, 
//* PARM=('PGM /usr/sbin/inetd /etc/inetd.conf') 
// PARM=('PGM /usr/sbin/inetd') 
//STDERR DD PATH='/etc/log',PATHOPTS=(OWRONLY,OCREAT,OAPPEND), 
// PATHMODE=(SIRUSR,SIWUSR,SIRGRP,SIWGRP) 
//SYSPRINT DD SYSOUT=*,DCB=(RECFM=F,LRECL=132,BLKSIZE=132) 
//SYSIN DD DUMMY 
//SYSERR DD SYSOUT=* 
//SYSOUT DD SYSOUT=*,DCB=(RECFM=F,LRECL=132,BLKSIZE=132) 
//CEEDUMP DD SYSOUT=* 
//STDENV DD DSN=TCPIP.TCPPARMS(INETDENV),DISP=SHR 

5. Populate /etc/services with valid values including the values for exec and 
login as shown below:

# 
# UNIX specific services 
# 
exec 512/tcp 
biff 512/udp comsat 
login 513/tcp 
who 513/udp whod 

Note:  A sample copy of  /etc/services is provided in /usr/lpp/tcpip/samples. 

6. Modify /etc/inetd.conf so that the lines for exec and login read as follows:

login stream tcp nowait OMVSKERN /usr/sbin/rlogind rlogind -m 
exec stream tcp nowait OMVSKERN /usr/sbin/orexecd orexecd -l -v 
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The format of the inetd.conf file is specified in the z/OS UNIX System Services 
Command Reference, the chapter entitled "INETD inetd daemon -- Provide Internet 
Service Management." 

Customization for the Java Services process

This customization step involves installing the startup for the Java Services process, a 
component of SCLM Administrator Toolkit.  The Java Services process component is 
required both for ISPF and GUI operation.

Your systems programmer should add the following to /etc/rc, as root:

$ nohup <base install directory/rseserver631>/bin/start_auz_daemons.sh &

To use an automated process:  Two jobs have been provided to automate the process 
of customizing the Java Services.  These are:

• AUZJSTOP -- This job stops the Java daemons.

• AUZJSTAR -- This job starts the Java daemons.

Both of these jobs are found in AUZ.SAUZSAMP, the sample library distributed with 
SCLM Administrator Toolkit.

To perform the actions manually:  You can continue to perform the Java Services 
customizaton manually.  You can verify java services is available by issuing:

$ netstat –a| grep <port number> where <port number> defaults to 4445

If Java Services ever needs to be restarted manually, issue:

$ <base install directory>/bin/start_jsp.sh

By default, SCLM Administrator Toolkit Java Services listens on port 4445. If you 
want to use a different port, run the AUZCUSTJ job in AUZ.SAUZSAMP and modify 
the AUZ_JAVA_SERVICES_PORT. 

Customization for the RSE daemon

If you have chosen to use the RSE daemon rather than REXEC, you will need to 
perform this customization step.   Your systems programmer should execute the 
following, as root:

$ cd <base install directory/rseserver631>
$ extattr +p auth

To use an automated process:  Two jobs have been provided to automate the process 
of customizing the RSE daemon.  These are:

• AUZJRSE  --  This job grants extended attributes to auth.sh, which is needed by 
the daemon, and uncomments RSE lines in the daemon’s start and stop scripts.

• AUZRXLOG  --  This job sets appropriate permission bits on rexx.sh.log.

Both of these jobs are found in AUZ.SAUZSAMP, the sample library distributed with 
SCLM Administrator Toolkit.

To perform the customizaton manually:  To perform the customization manually, 
follow the process described below:

1.  Start the RSE daemon at boot time by modifying your USS initialization shell 
script.  Edit the following lines to remove the pound sign (#) in the 
start_auz_daemons.sh script: 
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# Start RSE connection daemon
<base install directory/rseserver631>/daemon.zseries.sh &
sleep 5

2. By default, the RSE daemon listens on port 4035.  If you want to use a different 
port, add that port number to the second line of the example above.  This example 
below adds port 9000:

<base install directory/rseserver631>/daemon.zseries.sh 9000 &

3. If you change the port number to which the RSE daemon listens, you must also 
specify this changed port number in the appropriate field when you are using the 
client workstation to create a new connection (see “Configuring the client 
component” on page 29).

Note:  After the RSE daemon has been installed, the appropriate extended attributes 
must be set for the user authorization program. You will need permission to the 
BPX.FILEATTR.PROGCTL facility class.

Customizing RACF

The following changes are required to be made to RACF to run SCLM Administrator 
Toolkit. 

Specifying TSO(HOLDCLASS)  under RACF

SCLM Administrator Toolkit requires that  users have a HOLDCLASS specified in 
their TSO segment in order to create language definitions and architecture definitions 
from JCL.  Thus, the system’s security administrator  must take  action to update each 
user’s RACF profile.  One of the following methods can be used:

• When adding  or changing  a user ID:

1. Access RACF  Option 4 USER PROFILES AND YOUR OWN PASSWORD

2. On the second (ADD AN ID)  or third (CHANGE AN ID) RACF panel,  type YES on 
the line 

TO ADD OPTIONAL INFORMATION, ENTER YES ===>

3. Scroll to and select   

___TSO PARAMETERS

4. Scroll to the following and type an appropriate class

Change Hold Class  (HOLDCLASS__ 1—9, A—Z, or blank

• Alternatively,  from the RACF command line, enter

ALU xxxxxxxxTSO (HOLDCLASS(C))

where xxxxxxxx is the user ID to be updated and c is an appropriate class.

Specifying TSO region size under RACF

SCLM Administrator Toolkit requires that  users specify a maximum size value for 
their TSO region of at least 60000 if using XML toolkit V1R7.

Because the amount of memory below the line may be limited, a value of 20000 or 
greater is recommended. The system’s security administrator must take  action to 
update each user’s RACF profile.  One of the following methods can be used:

• When adding  or changing  a user ID:

1. Access RACF  Option 4 USER PROFILES AND YOUR OWN PASSWORD
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2. On the second (ADD AN ID)  or third (CHANGE AN ID) RACF panel,  type YES on 
the line 

TO ADD OPTIONAL INFORMATION, ENTER YES ===>

3. Scroll to and select ___TSO PARAMETERS   

4. Scroll to the following and type an appropriate class

Change Maximum Region Size (MAXSIZE)______0—2096128

• Alternatively,  from the RACF command line, enter

ALU xxxxxxxxTSO (MAXSIZE(nnnnn))

where xxxxxxxx is the userID to be updated and nnnnn is 60000 when using XML 
toolkit V1R7.

Modifying a user’s OMVS segment

Each user that is to use the SCLM Administrator Toolkit must have a USS OMVS 
segment that specifies:

• A maximum process size set to NONE

• A valid home directory

• A valid shell

• A valid non-zero uid. The user id must be unique for each user.

• RACF SPECIAL authority, if and only if that user will administer Enhanced 
Access Control for SCLM.

Customization required if you will migrate remote assets into SCLM

If you will use the SCLM Administrator Toolkit’s Remote Migration Wizard to place 
workstation objects under SCLM control, you will need to run an optional VSAM file 
definition job named AUZXLVSM located in the  <hilev>.SAUZSAMP library.

You must set the transfer mode to binary when used to send files to the host from the 
workstation.  For information on performing this task, see “Setting Remote Systems 
Explorer preferences” on page 33.

Customization required if you will obtain and view Enhanced Access 
Control for SCLM violations

If you are using Enhanced Access Control for SCLM and you want to be able to list 
violations, the full SMP/E life cycle for the Enhanced Access Control for SCLM 
product must be completed.  Module HSS.AHSSLOAD(HSSGDBUF), a component of 
Enhanced Access Control for SCLM that is used to obtain violations, must be 
available to the host components of SCLM Administrator Toolkit.  This module can be 
found in HSS.AHSSLOAD after you have performed an SMP/E ACCEPT on 
Enhanced Access Control for SCLM.  Either copy this module to AUZ.SAUZLOAD or 
to another link-listed library, or place HSS.AHSSLOAD in the link list. 

Starting an SCLM Administrator Toolkit host session

If you intend to use only the host component of the  SCLM Administrator Toolkit, you 
can now begin a host session as described in Chapter 6, “Starting an SCLM 
Administrator Toolkit Session,” on page 37.  
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Using the host-based download wizard to download the workstation 
component

SCLM Administrator Toolkit provides a wizard, available from the host system using 
ISPF,  to assist you in downloading the workstation component.    Using the wizard, 
you can specify the following:

• Whether you want to download the workstation component using FTP 

• The workstation type to which the component will be downloaded (see Table 1 on 
page 27).

• The directory to copy the downloaded file to and the data set from which the file 
will be copied.  You are given the option to create the workstation directory as 
part of the download process.

To download the workstation client, start an SCLM Administrator Toolkit host 
session.  From the Main Menu, select option 4, FTP. 

Downloading using FTP

 If you will use FTP, you must ensure that:

• A TCP/IP connection exists between the z/OS host and the workstation

• An FTP server is running on the workstation

If you have specified that FTP is to be used as the download method, you must also 
specify:

• The IP address or host name of the workstation

• The logon ID and password of the user to whom the workstation component will 
be addressed

Downloading manually

If you choose to download the workstation component manually, you may do so.

Ensure that you have set the transfer mode to binary.

Complete the installation by:  

1. Running the installation program on your workstation 

2. Running the PTF installation program on your workstation if necessary
 Chapter 3.   Installing and Customizing the Host Component  23



 

 24 IBM Software Configuration and Library Manager Administrator Toolkit:  Installation and Customization Guide  



Chapter 4. The Installation Verification Program

An installation verification program (IVP) that can be run from USS, TSO-E, and batch  
is shipped with SCLM Administrator Toolkit.    This job, AUZIVPJ, can be found in 
the product’s <hilev>.SAUZSAMP library.

Running the installation verification program

When running the IVP, you must not be the root user.  To  run the IVP in batch mode, 
you will need to perform the following customization on this file:

• The AUZ installation path must be specified on the BPXBATCH PARM line.

• You will need to review the STDENV parameters as follows:

— TESTGUI=Y|N will run a communications layer test of workstation connectivity. 
Specify N if you are using only ISPF.

— Use TESTHLQ=<hlq>  to set the valid high level qualifier for test project use 
(single level HLQ only).

— Use SISPMACS=<sispmacs dsn> to set the SISPMACS data set (normally 
ISP.SISPMACS).

— Use PSWDDSN=<password dsn> to specify a SAM data set name that contains 
your MVS password on line 1 in free format.  Ensure that it is RACF-
protected.  This step is not required if you specified TESTGUI=N.

Note:  This file contains both lower and upper case characters.   The case of the text 
must be preserved.    Also, the file must always be saved NONUM and some lines  
may have the backslash (\) character in column 80. These must also be preserved.
© Copyright IBM Corp.  2004, 2005  25



 

 26 IBM Software Configuration and Library Manager Administrator Toolkit:  Installation and Customization Guide  



Chapter 5. Installing and Configuring the Workstation Client

Once SCLM Administrator Toolkit has been installed and configured on the host, you 
will want to download, install, and configure  the workstation client.  Note that, 
because enterprises vary in their installation requirements, the configuration and 
customization information in this chapter may not be an exhaustive list of the changes 
required to be made to your installation. You must also ensure that the Java Services 
process has been customized as described in “Customization for the Java Services 
process” on page 20.

Installing the client

To begin the installation process for the client, access your host system to locate the 
PDS or PDS-E that contains the installer for your client environment.  The table that 
follows lists the names of the data sets that contain the installers, the names of the 
installers,  and the environments they support.  In the table, <hilev> identifies the 
high-level qualifier for the data set.

   

 

Each of the data sets above can be installed individually.  You may install as many as 
you need.  If you want to run the GUI client on a platform for which the installation 
data set is not present, you will need to contact your site’s systems programmer who 
is responsible for installation. 

Note:  SCLM Administrator Toolkit requires that it be installed into IBM Eclipse SDK 
3.0 or later.

Downloading the workstation component

Information about downloading the workstation component from the host is found in 
“Using the host-based download wizard to download the workstation component” 
on page 23.  The programs are self extracting executables.   Running them will result 
in files being generated in the directories on your workstation that you have specified.

Performing the installation

Before installing the client component, you must ensure that a Java Runtime 
Environment 1.4  has been installed.  

 Installing on Windows: If you are running on Windows:

1. Download the installation package SAUZGUIW to your workstation by 
performing a binary transfer using FTP or an equivalent transfer method. Place 
the installation package in a Temp folder. 

Table 1. Installation data sets and the platforms to which they apply

Installation data set  name Installer name Platform to which it applies

<hilev>.SAUZGUIW AUZWIN32 Windows® 2000
Windows XP

<hilev>.SAUZGUIA AUZAIX5L AIX 5L™

<hilev>.SAUZGUIK AUZLNGTK Linux® GTK
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2. Open the Temp folder.

3. Highlight auzwin32.  Rename this file to auzwin32.exe. 

4. Click auzwin32.exe to invoke the InstallShield MultiPlatform Installer.

Installing on a UNIX®-based system:  If you are running on a UNIX or Linux system, 
you must be running under the X Windows system. 

1. Run xterm or xcolor  to verify that your X server is operational.

2. Verify that the  DISPLAY environment variable is set to the location where you 
will monitor the application.  The statement to do so is:

"export DISPLAY=<display-location host name>:0"

3. Verify that  <display-location host name> can accept X connections by running  
xhost there.  Note that this step is not necessary if the system represented by 
<display-location host name> is the same host system on which you are installing 
the client; for example, "xhost +".

4. Change directories (cd) to a work directory that must have sufficient space to  
store an 800MB temporary file.  Download the installation package appropriate to 
your client workstation by performing a binary transfer using FTP or an 
equivalent transfer method. Place the installation package in a Temp folder.  The 
example below does so for an AIX system.

> "ftp <USS host>" and authenticate
> "binary"
> "lcd <local temp directory>"
> "cd ’AUZ.SAUZGUIA’"
> "get AUZAIX5L"
> "quit" or "bye" to exit

5. Once you have performed the binary FTP to move the appropriate installer (see 
Table 1 on page 27) to your client workstation, rename the downloaded file to a 
valid executable name for your platform; for example AUZAIX5L.bin for the AIX 
environment or AUXLNGTK.bin for Linux.

6. Run the installer to  invoke the InstallShield MultiPlatform Installer.  The example 
below performs this function for AIX. The statement chmod +x *.bin sets the 
execute permissions.

"cd <temp directory>"
"mv AUXAIX5L AUZAIX5l.bin"
"chmod +x *.bin"
"./AUZAIX5L.bin"

The InstallShield MultiPlatform Installer

While the InstallShield MultiPlatform Installer  is executing,  your screen will be blank 
for some period of time.  This is normal.  Please wait until the InstallShield Wizard 
appears, when you will be requested to take additional actions.

As the installation progresses, you will be asked where you would like to install 
SCLM Administrator Toolkit.  The default directory is <install>/IBM/
SCLMAdministratorToolkit. For Windows, install is C:/Program Files.  For AIX and 
Linux, it is /opt.  However, you may choose another directory if you wish. 

This completes the installation. 

Note:  If the installation process fails, the SCLM Administrator Toolkit installer may 
be unable to clean up its swap files. The names of these files vary because InstallShield 
generates unique names during each installation.  These files are usually in a directory 
that begins with the letters is.  The files can be found in your temporary directory or in 
the directory that is specified with the command line parameter ’is:tempdir: 
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"/my/swap/directory"’. These directories take up space and may hinder future 
installations.  You should, therefore, backup and then safely remove these directories.  

Temporary disk space for the installer

The SCLM Administrator Toolkit installation program needs a temporary area on disk 
with a sufficient amount of space.  Having 500MB of space should be sufficient, but 
you may need to tune this value depending on your installation.  During the 
installation process, you may receive the following message:

Error Writing File. There may not be enough temporary disk space. 
Try using -is:tempdir to use a temporary directory on a partition with more disk space.

If this message is displayed, specify a temporary area as follows:

mmmmmmmm -is:tempdir "directory-path"

where:

mmmmmmmm
is the name of an installer such as AUZWIN32.exe or AUZLNGTK.bin.

directory-path
represents the path to the temporary area on disk; for example, "/tmp/AUZ".

Uninstalling SCLM Administrator Toolkit

To uninstall SCLM Administrator Toolkit, invoke the Uninstall Wizard as follows:

1. Select Start > Programs > IBM SCLM Administrator Toolkit > Uninstall 
>Uninstall SCLM Administrator Toolkit. This invokes the Wizard.

2. When the Uninstall Wizard is displayed, you can choose to uninstall only SCLM 
Administrator Toolkit or you can also uninstall WebSphere® Studio Workbench 
(WSWB).  Once you have selected one or both of these products to be uninstalled, 
clicking Next starts the uninstall process.

3. The Uninstall Wizard confirms the uninstall of the product or products.  When 
you click Next on this panel, and if you have chosen to uninstal WebSphere 
Studio Workbench in addition to SCLM Administrator Toolkit, the Uninstall 
Wizard requests that you access the directory where WSWB had been installed 
and manually delete your .config and workspace folders.  This step is not 
required if you are removing only  SCLM Administrator Toolkit.

Installing the SCLM Administrator Toolkit client into an existing 
workspace

If you have installed  the  SCLM Administrator Toolkit client and choose to reinstall it 
into an existing workspace, you must first uninstall the previous installation of the 
product using the Uninstall Wizard as described in  “Uninstalling SCLM 
Administrator Toolkit”.   SCLM Administrator Toolkit preserves workstation client 
preferences and Remote Systems Explorer (RSE) configuration specifications  during 
the uninstallation/reinstallation process.

Configuring the client component

Follow these steps to configure your workstation client.  Once you have configured 
your client component, it will be unnecessary to repeat these steps unless you want to 
configure additional host connections.
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1. From the task bar, select Start > Programs and then IBM SCLM Administrator 
Toolkit to open a session.

2. When the initial SCLM Administrator Toolkit panel opens, select the SCLM 
Administrator Toolkit perspective by:

• Clicking the SCLM Perspective icon at the left of the screen, or

• Clicking the Open a Perspective icon  at the left of the screen and selecting 
SCLM Admin Toolkit, or

• From the Window pull-down, select Open Perspective  > SCLM Admin 
Toolkit.

3. Configure a connection to the host system by expanding the New Connection in 
the Remote Systems View in the left-hand pane of your workspace. From the list 
of host systems, click on the type of host you want to configure, in this case, z/OS.  

SCLM Administrator Toolkit presents you with the New Remote System 
Connection dialog.  Fill out the  fields on this panel.  You may have to obtain the 
information specific to your site from your systems programmer. Information on 
completing the dialog can also be found in the Remote Systems Explorer User’s 
Guide that is part of the Eclipse online Help.

• Parent Profile. Select the appropriate profile from the drop-down list.

• Connection Name. Enter the information required to create a connection to 
the host system where the SCLM project you want to administer resides.  You 
may choose any arbitrary value for the connection name.  The value you 
choose is the one that will be displayed in the Remote System View.

• System Type. If this entry field is included on the dialog, select  the 
appropriate system type from the drop-down list. (This field will not be 
present  if you selected the host type in the Remote System View.)

• Host Name. Enter the name of the host to which the workstation client will 
connect. 

• Description.  Enter a description for this host connection.

• Verify Host Name checkbox.  Place a check in this box if you want to verify 
the host name.  SCLM Administrator Toolkit will confirm that this host is 
available to be connected to. 

4. When you have completed the New Remote System Connection dialog, click 
Finish.

5. Configure the Files subsystem Server Launcher Settings page:

a. Right-click Files  in the Remote Systems View Navigation Tree in the left pane 
of  your workspace and, from the pop-up menu, select Properties.  SCLM 
Administrator Toolkit displays the Properties for Files dialog.

b. On the Properties for Files dialog, from the Navigator, select Server Launcher 
Settings.

c.  To indicate how the remote server should be launched, select either Remote 
daemon or REXEC by selecting the appropriate radio button.  

d. Enter the Port number for the port on the host system to which the client is to 
connect.  The standard daemon default is 4035.  The standard REXEC default 
is 512.  If your installation will use a different value, you may need to obtain 
this value from your systems programmer.

e. If you are using REXEC, enter the path to the remote server.  The path 
information is case-sensitive. The format of the path is 

/<install-directory>/AUZ/v210/rseserver631

 where the recommended installation directory is /usr/lpp. 
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f. If you are using REXEC, enter the name of the Server Launcher script by 
overtyping the default text with the text server.zseries.

g. Click Finish to complete this dialog. 

 

Setting preferences for SCLM Administrator Toolkit

Use the Preferences page to:

• Determine whether your SCLM Administrator Toolkit jobs will run in batch or in 
the foreground 

• Set default job card information

• Suppress RC=0 messages

• Specify the label for the project qualifier.  This value appears on the edit window 
tab and in the title bar after you have selected a project to work with

• Specify preferences for log files

• Define default types and associated parameters

 To access the Preferences page, from the Window pull-down, click  Preferences.  In 
the Navigation Tree that is presented to you, click SCLM Admin Toolkit.  After you 
have specified or modified your preferences, click OK to return to your project.

Some preferences, such as whether you want to run in foreground or in batch, and 
whether you want to use PDSs or PDS-Es, are stored in the project definition markup 
language (PDML).  The PDML is the XML representation of your project.  If you 
choose to change the value you have selected for these preferences, your change does 
not take effect until you save or rebuild the project.

Running jobs in batch or foreground and setting job card 
information

To set your preference for running jobs, access Preferences as described above.  Click 
the appropriate radio button. Then enter the job card needed to run your jobs in the 
text boxes provided.

Suppressing RC=0 messages

 Access Preferences as described above.  To suppress any RC=0 messages, place a 
check in the checkbox provided.  When you have completed your entries on this page, 
click Apply.  At any time, you can return to this page to modify your selection or to 
restore the product’s default settings.

Setting a label for the Edit tab and title bar

 Access Preferences as described above.  You can specify a label to be applied to the 
Edit tab and title bar when working with a project.  To  provide information for the 
Title Name Display Preference, select either Connection name or Host name  from the 
pull-down box.   The default is the Connection name, which is the name that appears 
in the Remote Systems tree at the left of your window.  When you have completed 
your entries on this page, click Apply.  At any time, you can return to this page to 
modify your selection or to restore the product’s default settings.
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Preferences for log files

The SCLM Administrator Toolkit Preferences page  provides two options for log files.  
One permits you to specify the maximum size for log files and is labeled Maximum 
size of log files in MB.  The maximum size, by default, is set to 5 megabytes.

A  check box labeled Automatically prune messages, if checked,  will cause SCLM 
Administrator Toolkit to check for log files size only once after a connection to a 
remote system is established. If the size is greater than the maximum size you have 
specified for log files, log files automatically will be deleted, oldest first, until the total 
size is less than the specified maximum size.  By default, Automatically prune 
messages is checked to enable the validation.  If this checkbox is not checked, a 
warning message showing the current size of the log files is displayed.

Defining default Types and setting their DCB values

SCLM Administrator Toolkit provides a number of  fully-defined default Types which 
you can choose to include in your project as is.  You can use the Default Types 
Preference page to modify the Type definition for these types or to define new Types.  
You may already have worked with the product’s default Types when customizing 
the workstation client. To access the Default Types Preference page, expand the SCLM 
Admin Toolkit item in the Preferences Navigator Tree by selecting the following from 
the Window pull-down: Window > Preferences > SCLM Admin Toolkit > Default 
Types Preference Page.  

To  add a default Type to your project, on the Preferences page, select the Type to be 
added from the list of default Types and click the Add button.    To edit an existing 
default Type, click the Edit button.  SCLM Administrator Toolkit displays the  Type 
Dialog on which you can specify or edit the selected Type information:

1. A name of up to 8 characters and a description for the Type. (If you are editing an 
existing Type, its name is filled in this field.)

2. The average number of records contained in the top-level data set of this Type. 
This mandatory value, together with the number of members value and the DCB, 
is used to calculate the space required for the PDS or PDS-E at the top of the 
promotion tree.

3. The number of members contained in the top-level Type data set. This mandatory 
value, together with the average number of records value and the DCB, is used to 
calculate the space required for the PDS or PDS-E at the top of the promotion tree.

4. An extended Type name of up to 8 characters that can be used as an alternate 
Type if it is necessary to resolve include dependencies.

If  a Type has been defined as using package backout:

1. Specify a number in the Reuse Days text box to indicate the number of days for 
which a backout can be performed. This field can only be specified if you check 
Backout IsaPack for this Type.

2. Click the Package Backup check box to specify that this Type of file is to be backed 
up during a promote.

3. Click the IsaPack check box to specify that this architecture definition will be used 
to drive the packages that are permitted to be backed out.  This flag can be 
specified only for architecture definition  (ARCHDEF) Types.

4. Click the Packfile box to specify that this Type is to hold the package detail files.

Specify the following default DCB information for the Type:

• The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM, 
or U. 
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• The default DCB block size. Valid value is an integer from 32 — 32760

• The default DCB logical record length. Valid value is an integer from 32 — 32756. 

Note:  When you add a new Type to your project, you should ensure that:

— If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0, 
and must be less than or equal to 32760.

— If RECFM=VBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be greater than LRECL + 4 and less than or equal to 32760.

— If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0, 
or must be an exact multiple of LRECL and less than or equal to 32760.

When you have completed your entries on this page, click OK.  At any time, you can 
return to this page to modify your entries, to remove a default Type from your profile, 
or to restore the product’s default settings.

Setting Remote Systems Explorer preferences

To set your Remote Systems Explorer preferences, select Window > Preferences > 
Remote Systems. 

• You should ensure that the Default File Transfer Mode is set to Binary in Window 
> Preferences > Remote Systems > Files in order to get project lists. 

• Optionally, check Show "New Connection" prompt in Remote Systems tree

• Checking Reopen Remote Systems View to previous state is used to reconnect 
open sessions, but can take a long time to complete. If you just want to work with 
one specific connection, it is recommended that you leave this box unchecked.  
This gives you additional flexibility in the time required to initiate a session.

For information about Remote Systems Explorer, see the Remote Systems Explorer 
User’s Guide that is part of the Eclipse online Help.

Note:   A Preferences page in RSE permits you to control file cache size and clear the 
cache. If you do so while you have an open project, you will impact your ability to 
correctly save your project. Thus, you must not clear the cache while you have 
projects open in SCLM Administrator Toolkit. 

Setting Enhanced Access Control preferences

Information about setting preferences for Enhanced Access Control for SCLM can be 
found in the SCLM Administrator Toolkit: User’s Guide in the chapter entitled "Getting 
Started with Enhanced Access Control for SCLM Administration."

Setting a project filter

You can filter the list of objects presented to you in the Navigator tree.  The filters you 
define are host-specific.  That is, if you create a filter on host A, that filter will apply 
only to host A and not to host B.  

When you first install SCLM Administrator Toolkit, the project filter is set to an 
asterisk (*).  All projects appear in your Navigator tree.  To change the filter, at any 
time,  you can right-click Project Filter in the Navigator Tree, then click Change in the 
pop-up menu that displays.  This causes SCLM Administrator Toolkit to display the 
Change System Filter menu on which you can add or change project filters.  You can 
also right-click on a filter listed in the Filter Strings list box on this menu to see 
additional options you can take against a specific filter.   You can define as many 
filters you you desire for each host connection.   
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Note:  A project filter is case-sensitive.  

To add a new filter, right-click SCLM Administrator Toolkit  in the Remote System 
View.  From the displayed pop-up, select New > Filter.  Type in the filter string that 
will perform the filter action.  Click Next to continue.  Enter a unique name for the 
filter and specify whether or not this filter will apply  only to this connection by 
checking the appropriate check-box.  Select the filter pool to which the filter will 
belong.  Click Next to  see some hints and tips about filters.  Then click Finish to save 
the filter you have defined. 

 To change or add to the filtering capabilities of an existing filter, right click its name in 
the Remote Systems View and select either Change or Properties > Filter Strings  
from the pop-up menu that is displayed.  Here you may add to or change the filter 
string for a named filter, or create an entirely new filter string for the filter. 

Starting an SCLM Administrator Toolkit session

Your SCLM Administrator Toolkit client is now ready for use.  To start a work session, 
see Chapter 6, “Starting an SCLM Administrator Toolkit Session,” on page 37.
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Part 3. Starting a Session

This part describes the way in which you start an SCLM Administrator Toolkit 
session.
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Chapter 6. Starting an SCLM Administrator Toolkit Session

Once you have completed the installation and customization tasks, you are ready to 
begin using the product.  Follow the directions below to start a session.  Detailed 
information about using SCLM Administrator Toolkit are available in the IBM SCLM 
Administrator Toolkit : User’s Guide.

Starting a session from the workstation client

To start a new SCLM Administrator Toolkit session  

1. Under Windows, log onto the product from the Start menu:
Start > Programs > IBM SCLM Administrator Toolkit. Alternatively, open a DOS 
window to the directory where you have installed SCLM Administrator Toolkit.  
At the command prompt enter  sclmadmintoolkit.bat.

In the UNIX or Linux client environments, ensure you are running under the  X 
Window system and the DISPLAY environment variable is set.  Change 
directories to the  eclipse directory by entering cd eclipse.  From a command 
prompt, enter sclmadmintoolkit.sh.

Note:  Using sclmadmintoolkit.sh is the only recommended way to begin your 
use of SCLM Administrator Toolkit.  Do not execute Eclipse. Do not start multiple 
instances of SCLM Administrator Toolkit simultaneously from the same user ID, 
since unpredictable results can occur. 

2. To connect to the host, click SCLM Admin Toolkit in the Remote Systems View 
navigator tree.  

3. Enter your logon ID and password when prompted. The first time you use the 
product, you should place a check next to Save ID on the logon pop-up.  You may 
optionally want to place a check next to Save Password, which makes it 
unnecessary to reenter your password once you have logged onto the system.

If you have saved your ID or password and need to reset one or both at a later 
date:

a. From the Window pull-down, select Preferences > Remote Systems > 
Passwords. 

b. From the list that displays, select the system on which you want to add, 
change, or remove password information and press OK. 

4. When your logon has been accepted, your host session begins. You can now  
create a new project or modify an existing project.

Starting a session from the host

To begin a host session, log onto ISPF and enter 10.8 on the command line.  This 
displays the SCLM Administrator Toolkit Main Menu from which you can choose the 
task you want to perform.

Note:  When you initially log onto TSO to use SCLM Administrator Toolkit, your user 
profile  should have been modified to specify an adequate maximum size for your 
TSO region under RACF.  Typically, this profile modification will have been made for 
you by your site’s systems programmer when setting up SCLM Administrator 
Toolkit. If you are using XML toolkit V1R7, your TSO maximum region size should be 
60000.  
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Part 4. Appendixes
© Copyright IBM Corp.  2004, 2005 39  



 

40 IBM Software Configuration and Library Manager Administrator Toolkit:  Installation and Customization Guide  



Appendix A.    Messages and Codes

The messages and codes that may be displayed during the operation of SCLM 
Administrator Toolkit, together with actions that may be taken by the system, as well 
as actions that you may need to take are documented in "Appendix A. Messages and 
Codes" in the  SCLM Administrator Toolkit: User’s Guide.
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Appendix B. Accessibility Features of the Workstation 
Component

Accessibility features help users who have a physical disability, such as restricted 
mobility or limited vision, to use software products successfully. This appendix 
describes the most commonly used accessibility features of  SCLM Administrator 
Toolkit. The following sections explain how to use these accessibility features on the 
Windows platform.

To review a complete list of the accessibility features supported by the Eclipse 
platform, refer to "Accessibility Features in Eclipse" in the "Concepts" section of the 
WebSphere Studio Workbench User Guide. To access this user’s guide, from SCLM 
Administrator Toolkit menu bar, select Help > Help Contents. Select Workbench 
User Guide from the list of topics that is displayed.

Operating SCLM Administrator Toolkit by using the keyboard 

SCLM Administrator Toolkit allows you to use the keyboard in place of the mouse for 
many functions. The product can be controlled to a large extent using keyboard 
shortcuts. You can use keys or key combinations to perform operations that can also 
be accomplished through mouse actions. You can access menu items  from the 
keyboard. You can review a subset of the keyboard shortcuts available to you using 
the Window > Keyboard Shortcuts dialog.  When using a pull-down menu, the 
keyboard equivalent typically appears to the right of the menu item. Some keyboard 
items also have shortcuts. Typically, the shortcut letter is underlined in the pull-down 
menu item’s command.  

Optionally, you can customize the function of your keyboard.  Information on how to 
do so can be found in the "Concepts" section of the WebSphere Studio Workbench 
User Guide.  Access the User Guide and then search on the term keys. To customize 
your keyboard while using SCLM Administrator Toolkit, select Window > 
Preferences > Workbench > Keys.

To navigate through a window or dialog by using the keyboard instead of the mouse, 
use the following keyboard shortcuts: 

   
Table 2. Navigating through a window or dialog using the keyboard 

Action Shortcut

Access the menu bar in a window F10 or Alt+shortcut letter

Activate a menu item in the menu bar  Enter

Cycle to editor Ctrl+F6

Cycle to a view Ctrl+F7

Cycle to a perspective Ctrl+F8

Access controls in a dialog Alt+shortcut letter

Navigate through the menu bar Right arrow, left arrow, down arrow, up 
arrow 

Move to the next set of controls Tab or Ctrl+Tab

Move to the previous set of controls Shift+Tab 
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To perform main tasks in windows by using the keyboard instead of the mouse, use 
the following keyboard shortcuts:

   

Move within tables Tab or right arrow, Shift+Tab or left arrow, 
down arrow, up arrow

Move within trees Up arrow, down arrow

Expand a tree node Right arrow

Collapse a tree node Left arrow

Move within list boxes Up arrow, down arrow 

Move within drop-down list boxes Up arrow, down arrow

Table 3. Keyboard shortcuts for windows

Action Shortcut

Display Help for the field that has the focus F1

Close the active window Ctrl+F4 or Alt+F4

Close all windows Ctrl+Shift+F4

Save Ctrl+S

Save all Ctrl+Shift+S

Properties Alt+Enter

Cut (Does not currently work in every SCLM 
Administrator Toolkit text field.)

Ctrl+X 

Copy (Does not currently work in every 
SCLM Administrator Toolkit  text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Copy from a pop-up menu.)

Ctrl+C

Paste (Does not currently work in every 
SCLM Administrator Toolkit text field. 
However, placing the cursor in a text field 
and right-clicking offers the opportunity to 
select Paste from a pop-up menu.)

Ctrl+V

Select all Ctrl+A

Find/Replace Ctrl+F

Print Ctrl+P

Return to previously displayed window 
(Back)

Alt+left arrow

Move forward to next window (Forward) Alt+right arrow

Go to last edit location Ctrl+Q

Search. 
Note that once the pop-up search dialog 
displays, press Shift+Tab to highlight the tabs 
in the search dialog and then the right or left 
arrows to move through the tab set.

Ctrl+H

Table 2. Navigating through a window or dialog using the keyboard 

Action Shortcut
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To perform main tasks in dialogs by using the keyboard instead of the mouse, use the 
following keyboard shortcuts:

   

 

Other accessibility features

In addition to the keyboard features described in this section, SCLM Administrator 
Toolkit permits the use of the following accessibility features provided by the Eclipse 
platform:

• Screen-reader software and a digital speech synthesizer to hear what is displayed 
on the screen

• Voice recognition software to enter data and to navigate the user interface

• The ability to magnify what is displayed on the screen in the graphical views

• The ability to modify fonts and colors using the Window > Preferences dialog

Table 4. Keyboard shortcuts for dialogs 

Action Shortcut

Confirm a dialog Enter

Cancel a dialog Esc

Activate a button that has the focus Spacebar or Enter

Select and deselect check boxes and radio 
buttons

Spacebar

Navigate forward within a check box and 
radio button group

Tab 

Navigate backward within a check box and 
radio button group

Shift+Tab 

Open drop-down list box menu Alt+down arrow 

Close drop-down list box menu Esc

Move up and down in combination box 
menu

Up arrow, down arrow

Activate drop-down list box menu item Enter

Move within a list box Up arrow, down arrow

Activate a list box entry Enter

Move between the pages of a window 
containing tabs if the tab has the focus

Right arrow, left arrow
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Appendix C. Notices

This information was developed for products and services offered in the U.S.A. IBM 
may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and 
services currently available in your area. Any reference to an IBM product, program, 
or service is not intended to state or imply that only that IBM product, program, or 
service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, 
it is the user's responsibility to evaluate and verify the operation of any non-IBM 
product, program, or service.

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY  10594-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM 
Intellectual Property Department in your country or send inquiries, in writing, to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other 
country where such provisions are inconsistent with local law: INTERNATIONAL 
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this publication 
at any time without notice.

Any references in this publication to non-IBM Web sites are provided for convenience 
only and do not in any manner serve as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product and use 
of those Web sites is as your own risk.

Licensees of this program who want to have information about it for the purpose of 
enabling: (i) the exchange of information between independently created programs 
and other programs (including this one) and (ii) the mutual use of the information 
which has been exchanged, should contact: 

IBM Corporation
J46A/G4
555 Bailey Avenue
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San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.

The licensed program described in this information and all licensed material available 
for it are provided by IBM under terms of the IBM Customer Agreement, IBM 
International Program License Agreement, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. 
Therefore, the results obtained in other operating environments may vary 
significantly. Some measurements may have been made on development-level 
systems and there is no guarantee that these measurements will be the same on 
generally available systems. Furthermore, some measurement may have been 
estimated through extrapolation. Actual results may vary. Users of this document 
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those 
products, their published announcements or other publicly available sources. IBM has 
not tested those products and cannot confirm the accuracy of performance, 
compatibility or any other claims related to non-IBM products. Questions on the 
capabilities of non-IBM products should be addressed to the suppliers of those 
products.

All statements regarding IBM's future direction or intent are subject to change or 
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to 
change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to 
change before the products described become available.

This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual business 
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which 
illustrates programming techniques on various operating platforms. You may copy, 
modify, and distribute these sample programs in any form without payment to IBM, 
for the purposes of developing, using, marketing or distributing application 
programs conforming to the application programming interface for the operating 
platform for which the sample programs are written. These examples have not been 
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply 
reliability, serviceability, or function of these programs.

If you are viewing this information softcopy, the photographs and color illustrations 
may not appear.

Trademarks

The following terms are trademarks of the IBM Corporation in the United States or 
other countries or both:
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InstallShield is a registered trademark of InstallShield Software Corporation.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the 
United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of 
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other 
countries.

Other company, product and service names may be trademarks or service marks of 
others.

AIX
IBM
RACF
Redbooks
WebSphere
z/OS 
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Bibliography

This bibliography lists the publications for IBM 
products that are related to the SCLM 
Administrator Toolkit product, or publications that  
you may need to consult when using the Toolkit. 
For a complete listing of,  and access to, all of the 
books in a particular library, visit the IBM web site 
at www.ibm.com and search for the library in 
question.  Links to some of the libraries cited in this 
bibliography can be found in the Preface to this 
manual.

Software Configuration and 
Library Manager Suite

 The documents in this section are those comprising 
the SCLM library and the libraries of products that 
are part of the SCLM Suite.

• z/OS ISPF  Software Configuration and Library 
Manager: Project Manager’s and Developer’s 
Guide, SC34-4817

• z/OS ISPF  Software Configuration and Library 
Manager: Reference, SC34-4818

• Software Configuration and Library Manager 
Administrator Toolkit: User’s Guide,  SC31-6571

• Software Configuration and Library Manager 
Administrator Toolkit: Installation and 
Customization Guide, GC31-6787

• Enhanced Access Control for SCLM for z/OS: 
User’s Guide, SC27-1591

• IBM Breeze for SCLM : Installation Guide, SC31-
8819

• IBM Breeze for SCLM : Planning and 
Administration Guide, SC31-8817

• IBM Breeze for SCLM : User’s Guide, SC31-8820

• IBM Cloud 9 for SCLM : Installation Guide,  SC31-
8845

• IBM Cloud 9 for SCLM : User’s Guide, SC31-8846

IBM Interactive System 
Productivity Facility (ISPF) for 
z/OS 

For information on navigating through ISPF, 
understanding PF key functions, and working in an 
ISPF  session, refer to the following manuals:

• ISPF: User’s Guide, Volume I, SC34-4822

• ISPF: User’s Guide, Volume II, SC34-4823

z/OS TSO/E

The following manuals provide introductory and 
use information about TSO/E.

• z/OS TSO/E: Primer, SA22-7787

• z/OS TSO/E: User’s Guide, SA22-7794

TCP/IP

The TCP/IP documentation is a part of the IBM 
z/OS Communications Server library. You will 
need to customize TCP/IP to invoke REXEC. The 
following manuals will assist you in making 
appropriate TCP/IP modifications:

• z/OS Communications Server: IP Configuration 
Guide, SC31-8775

• z/OS Communications Server: IP Configuration 
Reference, SC31-8776

z/OS UNIX System Services

Use the UNIX System Services documentation to 
understand how to enter shell commands to 
request services from the system; write and run 
shell scripts; switch between the shells and TSO/E; 
move MVS data sets into the file system or move 
files from the file system to MVS; enter shell 
commands; create or edit a file in the file system; 
and manage your file system.

• z/OS UNIX System Services : User’s Guide, SA22-
7801

• z/OS UNIX System Services : Planning, SA22-
7800

• z/OS UNIX System Services : Command Reference, 
SA22-7802

• z/OS UNIX System Services : Messages and Codes, 
SA22-7807

Additional Information

You may also want to refer to some of the IBM 
RedBooks, available online at www.ibm.com.  You 
may find the following useful:

• IBM RedBook: Hierarchical File System Usage 
Guide, SG24-5482
© Copyright IBM Corp.  2004, 2005  51



 

 52 IBM Software Configuration and Library Manager Administrator Toolkit:  Installation and Customization Guide  



Index

A
about SCLM Administrator Toolkit 

3
accessibility

navigating in a workstation 
panel vii

accessibility features vii
of the workstation component 

43
other 45
using the workstation keyboard 

43
activate OMVS 19
AIX

installing on 28
APF authorization

required for SAUZLOAD 10
required for XML LOADLIBs 

10
AUZ CLIST, customizing 11
AUZ.SAUZPAX 10
AUZCLIST 12
AUZFLM16, customizing 10
AUZFLMD 10
AUZFLMRN, customizing 10
AUZUNPAX, customizing 10
AUZUNPAX, modifying .profile 

when reinstalling SCLM 
Administrator Toolkit 10

B
block size, default DCB 32

C
CEE.SCEERUN

requirement to link-list 18
client, starting SCLM Administrator 

Toolkit session from 34
client, workstation

downloading from the host 23
CLIST AUZ

customizing 11
listing 12

CLIST AUZCLIST
customizing 11

CLIST customization
using correct case (upper or 

lower) when 
specifying parameters 
5

clone project, running in 
background 3

configure OMVS 19
configuring the workstation client 

27
copying from a text field vii
create project, running in 

background 3
customization

for the MVS component 10
for the RSE component 13
for the USS component 13
ispf.sh 14
RSE daemon 20

customizing
host part of RSE 14
MVS component 9

customizing AUZFLM16 10
customizing AUZFLMRN 10
customizing AUZUNPAX 10
customizing PARMLIB 18
customizing SCLM Administrator 

Toolkit 9
customizing TCP/IP to invoke 

REXEC 19
customizing the AUZ CLIST 11
customizing the host component 9
customizing the Java Services 

process 20
customizing the software 8
customizing the workstation client 

27, 29

D
daemon, RSE

customization for 20
DCB

default block size 32
default logical record length 32
default record format 32

DCB information, default 32
default DCB block size 32
default DCB information 32
default DCB record format 32
download wizard, using 23
download wizard, using FTP 23

E
Easy Cmd option

on SCLM Main Menu 10
Enhanced Access Control for SCLM 

violations
customization required to view 

22

F
filter, project

setting 33
FLMDMN, renaming 10

H
host component

installing and customizing 9
host component, customizing 9
host component, installing 9
host session, starting 22
host, starting a session on 37
HP-UX

installing on 28

I
initiating a host session 22
initiating a session using the 

workstation 34

installation
actions if installation fails 29
additional requirements 13
required products 7
specifying TSO(HOLDCLASS) 

21
temporary disk space for the 

installer 29
Installation and Customization

conventions used in v
terminology used in v

installer
sufficient temporary disk space 

for 29
installing

host part of RSE 14
MVS component 9
on UNIX-based systems 28
on Windows 27

installing into an existing workspace 
29

installing the host component 9
installing the workstation client 27
InstallShield MultiPlatform installer 

28
ispf.sh

listing 18
requirement to customize 14

J
Java Services process, customizing 

20

K
keyboard, using 43

L
Linux

installing on 28
listing

CLIST AUZ 12
ispf.sh 18
setup.sh 16

log directory permissions 14
log file preferences 32
logical record length, default DCB 

32
LookAt message retrieval tool vi
LRECL, default DCB 32

M
Main Menu, SCLM

customizing 10
message retrieval tool, LookAt vi
MVS component

customizing 9
installing 9

N
notices 47
© Copyright IBM Corp.  2004, 2005  53



 

O
OMVS REXEC, configuring and 

activating 19
OMVS segment, modifying user’s 

22
OMVS, configure and activate 19

P
PARMLIB, customizing 18
pasting into a text field vii
PDML 31
permissions, log directory 14
preferences

background
clone project 3
create project 3
VSAM file maintenance 3

for log files 32
Remote Systems Explorer 33
SCLM Administrator Toolkit 

31
running jobs online or in 

batch 31
setting DCB values for 

default Types 32
setting default job card 

information 31
products, required 7
products, required for installation 7
project definition markup language 

31
project filter

setting 33
Project Wizard

about 3

R
RACF

specifying TSO(HOLDCLASS) 
under 21

record format, default DCB 32
region size, TSO 21
reinstalling SCLM Administrator 

Toolkit
modify your .profile before 

running AUZUNPAX 
10

Remote Systems Explorer
customizing the host side of 13

Remote Systems Explorer 
preferences 33

required products 7
requirements, additional installation 

13
REXEC, invoking 19
RSE daemon

customization for 20
RSE, host part of

installing and customizing 14

S
SAUZLOAD

requirement to APF-authorize 
18

SAUZUNPAX 10
SCLM Administrator Toolkit

about 3
starting 34

SCLM Administrator Toolkit 
preferences 31

SCLM Main Menu, customizing 10
screen readers and magnifiers vii
session, host

starting 22
session, starting on the host 37
session, starting on the workstation 

37
setup.sh

installing and customizing 14
listing 16

SMP/E installation 9
software, customizing 8
Solaris

installing on 28
starting a host session 22
starting a session using the 

workstation 34
starting SCLM Administrator 

Toolkit from a client 34

T
TCP/IP, customizing to invoke 

REXEC 19
text field

copying from vii
pasting into vii
pasting into’ pasting into a text 

field vii
trademarks 48
TSO region size

specifying under RACF 21
TSO(HOLDCLASS), specifying 

under RACF 21

U
Uninstall Wizard 29
uninstalling the product 29
UNIX System Services

customizing 13
installation directories for 13

UNIX, installing on 28
UNIX-based systems

installing on 28
UNPAX, customizing 10
USS. See UNIX System Services

V
violations, Enhanced Access Control 

for SCLM
customization required to view 

22
VSAM file maintenance, running in 

background 3

W
Windows, installing on 27
wizard, download

using 23
using FTP 23

workstation
starting a session using 34

workstation client
downloading from the host 23
installing and configuring 27

workstation client, installing 27

workstation client, starting a session 
on 37
 54 IBM Software Configuration and Library Manager Administrator Toolkit:  Installation and Customization Guide  



Readers’ Comments—We’d Like to Hear from You

IBM Software Configuration and Library Manager Administrator Toolkit
 Installation and Customization Guide
Version 2  Release 1 

Publication No. SC31-6907-00
Overall, how satisfied are you with the information in this book?

How satisfied are you that the information in this book is:

Please tell us how we can improve this book:

Overall satisfaction

Very Satisfied           Satisfied                Neutral              Dissatisfied                Very
                                                                                                                                                         Dissatisfied

                                                                                                                             Dissatisfied
Very Satisfied           Satisfied                Neutral              Dissatisfied                Very

Accurate
Complete
Easy to find
Easy to understand
Well organized
Applicable to your tasks

Thank you for your response. May we contact you?    ❏  Yes    ❏   No

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏
❏
❏
❏
❏
❏

❏❏❏❏❏

When you send comments to IBM, you grant IBM a nonexclusive right to use or distribute your comments in any
way it believes appropriate without incurring any obligation to you.

AddressName

Company or Organization

Phone No.



    
Cut or Fold
Along Line

- - - - - - 

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

 

- - - - - - 

IBM@

SC31-6907-00

International Business Machines Corporation
IBM Corporation --Silicon Valley Laboratory 
Department DTX/E269 
555 Bailey Avenue 
San Jose, CA 
U.S.A. 
95141 - 9989
Fold and Tape Please do not staple Fold and Tape

Fold and Tape Fold and Tape

NO POSTAGE
NECESSARY
IF MAILED IN THE
UNITED STATES

BUSINESS REPLY MAIL
FIRST-CLASS MAIL PERMIT NO. 40 ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -
 - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
Please do not staple

SC31-6907-00
INTERNATIONAL BUSINESS MACHINES CORP
Silicon Valley Laboratory -- Department DTX/E269
555 Bailey Avenue
San Jose, CA 95141-9989
Cut or Fold
Along Line

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_
_

_

_

_





IBM@
Program Number: 5697-J19

Printed in USA
SC31-6907-00

*07SC31690700*


	About this book
	Who should read this book
	Conventions and terminology used in this book
	Terminology used in this book
	Service updates and support information
	Using LookAt to obtain message explanations
	Where to find information
	Accessibility features
	Navigating in a workstation panel
	Copying and pasting while using the workstation interface

	How to send your comments
	What’s new in Version 2.1

	Part 1. Introduction
	Chapter 1. About the SCLM Administrator Toolkit
	Support for Enhanced Access Control for SCLM Administration
	Hardware and software requirements
	Hardware requirements
	Software requirements


	Part 2. Installation and Customization
	Chapter 2. Planning for Installation
	Gather the required information
	Decide on the interface you will use
	Install any required products and check the maintenance level of your installed products
	Customize the software
	Involve the appropriate people

	Chapter 3. Installing and Customizing the Host Component
	SMP/E installation
	Installing and customizing the MVS component
	APF authorization 
	Customizing AUZUNPAX
	Customization required to modify the SCLM Main Menu 
	Customizing the AUZ CLISTs

	Customizing the USS components
	Log directory permissions
	Customizing IBM Workload Manager (WLM)
	Customizing setup.sh and ispf.sh 
	Batch program to customize setup.sh and ispf.sh
	Customizing setup.sh 
	Customizing ispf.sh

	Customizing PARMLIB
	Customizing TCP/IP to invoke REXEC
	Customization for the Java Services process
	Customization for the RSE daemon
	Customizing RACF
	Specifying TSO(HOLDCLASS) under RACF
	Specifying TSO region size under RACF
	Modifying a user’s OMVS segment

	Customization required if you will migrate remote assets into SCLM
	Customization required if you will obtain and view Enhanced Access Control for SCLM violations
	Starting an SCLM Administrator Toolkit host session
	Using the host-based download wizard to download the workstation component
	Downloading using FTP
	Downloading manually


	Chapter 4. The Installation Verification Program
	Running the installation verification program

	Chapter 5. Installing and Configuring the Workstation Client
	Installing the client
	Downloading the workstation component
	Performing the installation
	The InstallShield MultiPlatform Installer
	Temporary disk space for the installer
	Uninstalling SCLM Administrator Toolkit
	Installing the SCLM Administrator Toolkit client into an existing workspace

	Configuring the client component
	Setting preferences for SCLM Administrator Toolkit
	Running jobs in batch or foreground and setting job card information
	Suppressing RC=0 messages
	Setting a label for the Edit tab and title bar
	Preferences for log files
	Defining default Types and setting their DCB values

	Setting Remote Systems Explorer preferences
	Setting Enhanced Access Control preferences
	Setting a project filter
	Starting an SCLM Administrator Toolkit session

	Part 3. Starting a Session
	Chapter 6. Starting an SCLM Administrator Toolkit Session
	Starting a session from the workstation client
	Starting a session from the host

	Appendix A. Messages and Codes
	Appendix B. Accessibility Features of the Workstation Component
	Operating SCLM Administrator Toolkit by using the keyboard 
	Other accessibility features

	Appendix C. Notices
	Trademarks

	Bibliography
	Software Configuration and Library Manager Suite
	IBM Interactive System Productivity Facility (ISPF) for z/OS 
	z/OS TSO/E
	TCP/IP
	z/OS UNIX System Services
	Additional Information




